
EVM User's Guide: TPS65215Q1EVM
TPS65215-Q1 Evaluation Module

Description
The TPS65215Q1EVM is a fully assembled platform 
for evaluating the performance and functionality of 
the TPS65215-Q1 power management IC (PMIC). 
The EVM includes an onboard USB-to-I2C adapter, 
power terminals, and jumpers for all DC regulator 
inputs and outputs, as well as test points for common 
measurements.

Features
• GUI support to read and write to device registers 

along with being able to view and export register 
data

• USB2ANY adapter port for I2C communication 
with host computer

• Optional support for USB-A to Micro-USB 
connection for I2C communication
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1 Evaluation Module Overview

1.1 Introduction
The TPS65215-Q1 EVM is designed for evaluating the TPS65215-Q1 PMIC. The EVM operates with an input 
voltage range of 2.5V to 5.5V. The evaluation module has a graphical user interface (GUI) used to read and write 
to device registers and perform non-volatile memory (NVM) programming.

CAUTION
To minimize the risk of damaging LDO1, operate the EVM strictly at 3.3V input voltage when 
VINLDO1 is set to VSYS and the VSEL jumper is configured as high.

This user’s guide describes the characteristics, operation, and use of the TPS65215-Q1 EVM. This document 
includes a schematic, reference printed circuit board (PCB) layouts, and a complete bill of materials (BOM).

1.2 Kit Contents
• TPS65215Q1EVM Circuit Board
• USB-A to Micro-USB cable

1.3 Specifications
Figure 1-1 shows the functional block diagram of the TPS65215-Q1 PMIC.
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Figure 1-1. TPS65215-Q1 Functional Block Diagram
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1.4 Device Information
The TPS65215-Q1 PMIC is a highly integrated power management design for Arm® Cortex®-A53 Processors 
and FPGAs. This device combines three step down converters and two low-dropout (LDO) regulators. The 
Buck1 step down converter supports a load current of up to 3.5A, designed for the core rail of a processor. 
All three step down converters support non-fixed switching frequency or fixed frequency mode. LDO1 is 
configurable in both load switch and bypass-mode to support SD-Card configuration. All LDO voltage inputs 
cascade off the system power or the step down converter outputs to enable maximum design and sequencing 
functionality. Complete with one GPIO, two GPOs, and three Multi-Function-Pins (MFPs), TPS65215-Q1 offers 
the complete package for full control of the power and sequencing of a System on Chip (SoC).

1.5 Caution

CAUTION

!
Read the user's guide before use.

CAUTION

Hot surface. Contact can cause burns. Do not touch!
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2 Hardware

2.1 Setup
The minimum hardware requirements are needed to operate the EVM:

• EVM
– The TPS65215-Q1 evaluation board.

• Host computer
– A computer with an available USB port is required to make use of the EVM software. The EVM software 

runs on the computer and communicates with the EVM via a USB-A to micro-B cable.

• Power supply
– An input voltage source capable of supplying 3.3V.

2.2 TPS65215-Q1 Resources Overview
The TPS65215-Q1 PMIC contains five regulators; 3 buck regulators and 2 low drop-out regulators (LDOs). 
The buck converters are capable of supporting up to 3.5A for buck1, and 1.5A each for the remaining 
buck regulators. LDO1 (400mA) is configurable as an LDO, load switch, or bypass mode. LDO2 (300mA) is 
configurable as an LDO or load switch. With a VIN range of 2.5V to 5.5V, the PMIC supports a common 
3.3V system voltage. When VSEL jumper is set to high, LDO1 is set to bypass 3.3V input from the system 
voltage. Set the VSEL jumper low to set LDO1 to a fixed 1.8V LDO. Table 2-1 shows a summary of the voltage 
and current capabilities for each of the analog resources. With an I2C interface, three GPIO pins, and three 
multi-function-pins, the TPS65215-Q1 PMIC provides the full power package to meet the requirements of a 
variety of SoCs.

Table 2-1. TPS65215-Q1 Power Resources
Input Voltage Output Voltage Current Capability Comments

BUCK1 2.5V - 5.5V 0.6V - 3.4V 3.5A • 2.3MHz switching frequency.

• Dynamic voltage scaling.

• Programmable power sequencing and default 

voltages.

• Integrated voltage supervisor for undervoltage.

BUCK2 2.5V - 5.5V 0.6V - 3.4V 1.5A

BUCK3 2.5V - 5.5V 0.6V - 3.4V 1.5A

LDO1 1.5V - 5.5V (LDO, Load-
Switch)

1.5V - 3.4V (bypass)

0.6V - 3.4V (LDO)
1.5V - 3.4V (bypass)

400mA • Programmable power sequencing and default 

voltages.

• Configurable as load switch and bypass-mode.

• Integrated voltage supervisor for undervoltage.

LDO2 2.2V - 5.5V 1.2V - 3.3V 300mA • Programmable power sequencing and default 

voltages.

• Configurable as load switch.

• Integrated voltage supervisor for undervoltage.

2.3 EVM Configuration
Configure the TPS65215Q1EVM as follows. The following sections outline how to configure the 
TPS65215Q1EVM for general experimentation.

1. Configure regulator input supply rails for the expected application using the jumpers indicated in the Supply 
Voltage Setup.

2. Configure the multi-function pins externally using the mode configuration descriptions indicated in ulti-
Function Pin Setup. Please note that the default configuration for regulator choice in SD or DDR voltage 
selection differs for each individual NVM configuration (polarity is configurable).

3. Connect VSYS to a power supply capable of supporting the application and enable the supply.
4. If using a version of TPS65215-Q1 configured for first supply detection (FSD), then the power-up sequence 

is executed as soon as a valid supply is connected to VSYS.
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2.3.1 Default EVM Configuration

This section describes the default configuration programmed on the TPS65215-Q1 PMIC.

The TPS65215Q1EVM comes with the TPS6521501-Q1 PMIC installed, which is one of the orderable part 
numbers of the TPS65215-Q1 device family. The default output voltages for the Bucks and LDOs are shown in 
Figure 2-1. This information is based on the programmed default configuration on the TPS65215-Q1EVM. Refer 
to the device data sheet for more information about the settings that are reconfigurable, and the associated I2C 
registers.

Note
The TPS65215Q1EVM is designed to demonstrate some of the potential uses of the PMIC family. The 
EVM has more limitations than the TPS65215-Q1 device.

Buck1 = 0.75V Buck2 = 1.8V Buck3 = 1.1V

LDO2 = 1.8V

LDO1 = 3.3V (VSEL HIGH)

LDO1 = 1.8V (VSEL LOW)

Input Supply

3.3 V

uUSB connector for I2C 

communica�on with PMIC 

(op�onal)

Figure 2-1. TPS65215Q1EVM Default Configuration - Output Voltages

Use the multiple headers of the TPS65215Q1EVM to change the input supply for some of the power rails. The 
PCB also includes headers that allow for changing specific functions of the PMIC using the multi-function pins. 
An overview of the jumper options for each header is shown in Figure 2-2. All the headers and the expected 
configuration for each selection are listed in Table 2-2.
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Con�gured as WARM reset

High: normal opera�on

Falling edge: warm reset

Con�gured as VSEL_SD to set 

the output voltage of LDO1

High: LDO1 = 3.3 (requires VIN_LDO1 = VSYS = 3.3V)

Low: LDO1 = 1.8V (LDO1 behaves as a �xed 1.8V LDO)

Bucks switching mode

High: forced-PWM

Low: auto-PFM

Supply selec�on for PMIC LDOs

VIO supply selec�on

“MCU3V3” is an external discrete 3.3V LDO

“VBUCK2” is the PMIC BUCK2

Input supply for discrete 3.3V LDO

Push-bu�on connected 

to PMIC enable pin

Figure 2-2. TPS65215Q1EVM Default Configuration - Jumpers

Table 2-2. TPS65215Q1EVM Default Jumper Configuration
Header Jumper Default Position

Supply voltage setup

J3 VIN_LDO1
Supply selection for LDO1
Default: setup to supply LDO1 with VSYS

J10 VIN_LDO2
Supply selection for LDO2
Default: setup to supply LDO2 with VSYS

J11 EXTLDO_VIN
Supply selection for the external discrete LDO.
Default: setup to supply the discrete 3.3V LDO with VSYS

J4 VIO
VIO supply selection
Default: setup to use external 3.3V discrete LDO as the pull-up supply for 
the I2C pins and digital input pins)

Multi-function pin setup

J5 VSEL
High = sets 3.3V output voltage on LDO1 if the LDO is supplied by a 3.3V 
source. (default EVM config)
Low = sets 1.8V output voltage on LDO1

J8 MODE/STBY
Bucks switching mode
High = forced-PWM (default EVM config)
Low = auto-PFM

J12 MODE_RESET
High = normal operation (default EVM config)
Low = performs a warm reset (reset target voltage and Bypass mode 
configs to the default NVM values)
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2.3.2 Test Points

The TPS65215Q1EVM EVM contains multiple test points for various measurements. Trace assignments to the 
test points are shown in the table below.

Table 2-3. TPS65215-Q1 EVM Test Points
Test Point Associated Trace

TP1 VSEL_SD/VSEL_DDR

TP2 GND

TP3 VSYS

TP4-5 GND

TP6 VDD1P8

TP7-10 GND

TP11 MODE/STBY

TP12 GND

TP13 GND

TP14 PB / EN

TP15 Buck 1 Output SENSE

TP16 Buck 2 Output SENSE

TP17 Buck 3 Output SENSE

TP18 LDO 1 Output SENSE

TP20 LDO 2 Output SENSE

TP22 MODE/RST

TP23 Buck 1 Output

TP24 Buck 2 Output

TP25 Buck 3 Output

TP26 LDO 1 Output

TP28 LDO 2 Output

TP30-36 GND

TP37 GPIO

TP38 GPO1

TP39 GPO2

TP40 nINT

TP41 nRSTOUT

TP42 SDA

TP43 USB_5V

TP44 GND

TP45 SCL

TP46 MCU3V3
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3 Software

3.1 Graphical User Interface (GUI)
This section covers the usage and capabilities of the TPS65215 Graphical User Interface (GUI) tool from Texas 
Instruments.

Use the TPS65215-GUI in your browser or as a standalone application. This software provides a simple way to 
communicate with the device via I2C using the built-in USB2ANY utilizing an on-board MSP430.

3.1.1 Getting Started

Getting started involves the following steps:

1. Find the GUI within the Gallery
2. Download the required software

a. GUI composer Runtime for running the GUI from a web browser
b. An offline copy of the GUI

3. Launch the GUI

3.1.1.1 Finding the GUI

The PMIC GUI is based upon GUI Composer which is compatible with either Chrome® (version 46+) or 
Firefox® (version 38+). The Chrome web browser is recommended and used throughout this document for 
demonstration. The PMIC GUI is also compatible with Microsoft Edge® (as of version 111.0.1661.41). The GUI 
is found through the TI Development tools at TI DevTools page. Navigating to the Gallery from the Tools tab, 
highlighted in blue in Figure 3-1, is one way to enter the Gallery.

Figure 3-1. GUI Composer Gallery

In the gallery, locate the TPS65215_GUI panel shown in Figure 3-2 by using the search bar and entering 
TPS65215_GUI.
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Figure 3-2. Locating the PMIC GUI in the Gallery

3.1.1.2 Downloading the Required Software

Both the standalone GUI and the GUI Composer Runtime are available from the PMIC panel. Again, the GUI 
Composer Runtime enables the GUI to be run through a web browser but requires an internet connection to be 
able to run the GUI. By contrast, the standalone GUI is much larger but does not require an internet connection.

The download options are found in the pop-up window, as shown in Figure 3-3, when the cursor is placed on the 
download icon. The upper three options offer a standalone download for the appropriate operating system, while 
the lower three are for the GUI Composer Runtime.

Figure 3-3. GUI Software Download Options
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3.1.1.3 Launching the GUI

After the appropriate software has been downloaded, the locally launch the GUI from the PC application or from 
the TI Cloud using the Gallery. To use the TI Cloud version of the GUI, simply click anywhere in the panel, shown 
in Figure 3-4, that is not associated with the download or information icons.

Figure 3-4. GUI Panel Within the Gallery

3.1.1.4 Connecting to the EVM

The README text box helps users connect the EVM board to the computer. Use the Help tab in the top left of 
the GUI dashboard to access the README text box and the About option for information about the GUI version 
and additional documentation regarding the GUI.

After users have dismissed the README message box, the GUI displays the Home page, shown in Figure 3-5, 
with an overview of the TPS65215-Q1 block diagram.

At the bottom of the Home page, navigate to the other GUI pages, which are described in the subsequent 
sections. These pages are also found on the left side of the GUI interface.
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Figure 3-5. GUI Home Page

3.1.2 Collateral Page

The collateral page, shown in Figure 3-6, contains relevant documentation for using the TPS65215-Q1 PMICs. 
The collateral page contains links to the EVM User’s Guide and TPS65215-Q1 data sheets.

At the bottom of the page, there is a link to our E2E forums for technical questions about the GUI or PMIC.

Figure 3-6. Collateral Page
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3.1.3 Register Map Page

The register map page lists the different registers available for configuration and is intended for direct reads and 
writes to the PMIC registers, as shown in Figure 3-7. Reading and writing registers are either done individually 
or all at once. Enable the Auto Read feature by using the drop-down menu next to the READ ALL REGISTERS 
button to select an automatic read timing. Use the search bar at the top of the page to search registers by name 
or address.

The first three columns under the search bar show the name of each register, followed by the hexadecimal 
address and data value. The Bits column contains the bit values for each register and can be hidden by 
unchecking the Show Bits box at the top of the page, under the READ ALL REGISTERS button. Double-clicking 
a bit in this section changes the bit value.

The Field View section on the right side of the page shows register bits grouped by the respective control blocks. 
Click on any bit field box to see the corresponding bits highlighted in yellow in the Bits column. Each field has 
a name shown by the blue text at the top of each box. Find these names using the search bar by checking the 
Search Bitfields box (next to Show Bits).

In the Immediate Write mode (drop-down option located at the top right of the page), write buttons are grayed 
out since individual registers are written immediately with each change in the Field View, change in bits, or 
change in hexadecimal value. In Deferred Write mode, the writing of a single register or all registers is deferred 
until the WRITE REGISTER or WRITE ALL REGISTERS button is selected.

Figure 3-7. Register Map Page

Note
Although visible from the Register Map, not all registers are editable from this page. Attempting a write 
to a read-only register does not generate an error. Since each write is comes with an associated read, 
the Register Map display is updated to reflect that the bits were not changed by the write attempt.
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3.1.4 NVM Configuration Page

The NVM Configuration page (shown in Figure 3-8) is the main feature of the GUI and highlights the 
configurability of the PMIC. On this page, register fields are grouped according to the use case and are labeled 
to indicate which part of the PMIC is controlled by each block. The NVM configuration page also provides the 
interface to save a custom configuration or load an existing configuration into the NVM of the target device. A full 
register read is done using the READ ALL REGISTERS button in the top left of the page.

Figure 3-8. NVM Configuration Page

3.1.4.1 NVM Fields

Register settings are editable on the NVM Configuration Page and follow the register write setting specified on 
the Register Map page (Immediate or Deferred).

The PMIC Status tab holds a collection of read-only status registers that show the Device ID values as well as 
all the power rail enables and interrupts, which are displayed as digital LEDs. This section provides fast visual 
feedback on the PMIC and the operating conditions.

The Power Resources tab holds register settings for each power rail of the PMIC. Here, users also find 
a reference table for LDO1 and LDO2 configuration settings (for more information on the Load Switch and 
BYPASS modes, refer to the device data sheet which is included on the Collateral page).

The Sequence tab is used to control power rail sequence and timing registers for both power-up and power-
down.

The Digital Pins Configuration tab is used to control settings for digital I/O pins (for details on multi-function pins, 
see the PMIC data sheet).

The Mask Settings tab allows users to control fault reporting for PMIC protection features, which includes 
masking for undervoltage, temperature, and interrupt signals.
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3.1.4.2 Create and Load a Custom Configuration

The NVM Configuration page does not require hardware to develop an NVM configuration. Connection with an 
actual device is needed only when attempting to upload to a target device.

Once the registers are set to your desired configuration, use the Register File Format option, under the File tab 
at the top of the screen, to select a format for your configuration file (shown in Figure 3-9). Save the register 
configuration in either a CSV (Comma Separated Values) or a JSON (Javascript Object) format. Next, use the 
Save Registers As… option to save your configuration in your selected format. Once the file is created, save 
any changes you make to the register configuration using the Save Registers option. This option saves to the 
currently loaded configuration.

To load an existing configuration into the NVM, use the Load Registers option and browse to the configuration 
file location.

Figure 3-9. Save/Load Register Options

3.1.5 Sequence Configuration

The TPS65215-Q1 GUI features sequence configuration tabs for modifying and plotting the power-up and 
power-down sequences. The power-up sequence and power-down sequence tabs plot the voltage level of each 
signal as a function of time based on the corresponding settings.
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Plotting Features

The features of the sequence configuration tabs is demonstrated in Figure 3-10.

1

3

4

6

2

5

7

Figure 3-10. Sequence Plotting Tool

Note
Graph rise and fall time durations are not accurate. The actual rise and fall times dependent on load 
capacitance and other variables.

1. Power-up sequence and power-down sequence plotting tabs.
2. Rails disabled in active state always remain low when plotted. Configure these settings in the "Power 

Resources or Digital Pins Configuration tab.
3. Slot Assignment: There are 16 possible slot assignments (Slot 0 to Slot 15) assigned to each rail for flexible 

power sequences.
4. Slot Duration: There are four possible slot durations (0ms, 1.5ms, 3ms, 10ms) assigned to each slot for 

flexible power sequences.
5. Plot menu bar appears upon hovering over graph. This feature is explained in Menu Bar Options
6. Click on a signal in the legend to change the visibility.
7. Plot the design by pressing the Generate Plot button. Signal order is sorted based on which signals rise or 

fall first

Menu Bar Options

The plot menu bar has several settings including:
• Camera: download plot as PNG
• Zoom: left click and drag the mouse on the graph to zoom into the selected area. Enabled by default.
• Pan: left click and drag the mouse to navigate the plot.
• Zoom in
• Zoom out
• Auto-scale graph
• Reset axis
• Toggle like spikes
• Show closest data on hover
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• Compare data on hover. Enabled by default.

3.1.6 NVM Programming Page

The NVM Programming page allows re-programming the device NVM memory to change the default register 
settings. This page includes four main functions that correspond to the buttons shown in Figure 3-11. The first 
two steps I2C OFF REQUEST and ENABLE I2C COMMUNICATION are only needed when re-programming the 
PMIC from the Initialize state (PMIC rails OFF).

• The I2C OFF REQUEST button triggers an OFF request though I2C and sends the PMIC to INITIALIZE 
state.

• The ENABLE I2C COMMUNICATION button enables I2C communication in INITIALIZE state.
– Once I2C communication is enabled, go to the NVM configuration page to select the desired register 

settings or use the File tab options to load a pre-configured JSON or CSV file.
• The NVM PROGRAMMING button programs the selected register settings into the NVM.
• The VALIDATE NVM PROGRAMMING button reads the NVM content and compares with the selected 

register settings. The result (PASS or FAIL) is stored in register 0x34, field 7 NVM_VERIFY_RESULT.

Figure 3-11. NVM Programming Page

3.1.7 Additional Features

In the Options tab at the top of the GUI interface, select Serial Port… to display information about the EVM 
connection to the computer.

The Tools tab includes the Log pane option. Select this option to open a window that lists recent messages 
and warnings from the GUI application. These reports are marked with the date and time that each one was 
received. In the top right of the log window, filter out the different information types, save the list of events, and 
clear or close the log window.
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4 Hardware Design Files
4.1 TPS65215Q1EVM Schematic
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4.2 TPS65215Q1EVM PCB Layers

Figure 4-3. TPS65215Q1EVM Top Layer

Figure 4-4. TPS65215Q1EVM - Signal Layer1
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Figure 4-5. TPS65215Q1EVM - Signal Layer2

Figure 4-6. TPS65215Q1EVM - Signal Layer3
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Figure 4-7. TPS65215Q1EVM - Signal layer4

Figure 4-8. TPS65215Q1EVM - Bottom Layer
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4.3 TPS65215Q1EVM Bill of Materials
Table 4-1. Bill of Materials

DESIGNATOR QUANTITY VALUE DESCRIPTION PART NUMBER MANUFACTURER
C1, C2, C4, C6 4 0.1uF CAP, CERM, 0.1uF, 10V,+/- 10%, X7S, 0201 GRM033C71A104KE14D MuRata

C3, C5, C7, C9, C10, C31 6 4.7uF CAP, CERM, 4.7uF, 10V, +/- 10%, X7S, 0603 C1608X7S1A475K080AC TDK

C11, C13, C15, C23, C24 5 2.2uF CAP, CERM, 2.2uF, 10V, +/- 10%, X7S, 0402 C1005X7S1A225K050BC TDK

C16, C18, C20, C21 4 22uF CAP, CERM, 22uF, 10V, +/- 20%, X7R, 0805 GRM21BZ71A226ME15L MuRata

C25 1 3300pF CAP, CERM, 3300pF, 50V, +/- 10%, X7R, 0603 C0603C332K5RACTU Kemet

C26 1 100pF CAP, CERM, 100pF, 16V, +/- 10%, X7R, 0201 GRM033R71C101KA01D MuRata

C27 1 0.47uF CAP, CERM, 0.47µF, 16V,+/- 10%, X7S, 0402 CGA2B1X7S1C474K050BE TDK

C28 1 220pF CAP, CERM, 220pF, 16V, +/- 10%, X7R, 0201 GRM033R71C221KA01D MuRata

C29, C34, C35 3 0.1uF CAP, CERM, 0.1uF, 16V, +/- 10%, X7R, 0402 GCM155R71C104KA55D MuRata

C30 1 1000pF CAP, CERM, 1000pF, 50V, +/- 10%, X7R, 0603 C0603C102K5RACTU Kemet

C32, C33 2 22pF CAP, CERM, 22pF, 50V, +/- 5%, C0G/NP0, 0603 06035A220JAT2A AVX

D1, D2, D3, D4, D5 5 Green LED, Green, SMD LG M67K-G1J2-24-Z OSRAM

D6 1 Green LED, Green, SMD 150060VS75000 Wurth Elektronik

H1, H2, H3, H4 4 Bumpon, Hemisphere, 0.44 X 0.20, Clear SJ-5303 (CLEAR) 3M

J1, J6, J7, J18 4 Header, 100mil, 2x1, Tin, TH PEC02SAAN Sullins Connector Solutions

J3, J4, J10, J11 4 Header, 100mil, 2x2, Tin, TH PEC02DAAN Sullins Connector Solutions

J5, J8, J12 3 Header, 100mil, 3x1, Gold, TH TSW-103-07-G-S Samtec

J16 1 Header (shrouded), 100mil, 5x2, High-Temperature, 
Gold, TH

N2510-6002-RB 3M

J17 1 Connector, Receptacle, Micro-USB Type AB, R/A, 
Bottom Mount SMT

475890001 Molex

J19 1 JUMPER TIN SMD S1911-46R Harwin

L1 1 0.47uH 470nH Shielded Wirewound Inductor 7A 23mOhm Max 
2-SMD

SRP3020TA-R47M Bourns

L2, L3 2 0.47uH Thin Film Power Inductor 0.47uH 20% 4.5A 29mOhm 
0805

TFM201208BLE-R47MTCF TDK

LBL1 1 Thermal Transfer Printable Labels, 0.650" W x 0.200" H - 
10,000 per roll

THT-14-423-10 Brady

Q1, Q2, Q3 3 30V N-Channel NexFET™ Power MOSFET CSD17318Q2 Texas Instruments

Q4, Q5 2 -20V MOSFET, P-CH, -20V, -20A, DQK0006C (WSON-6) CSD25310Q2 Texas Instruments

Q6 1 50V MOSFET, N-CH, 50V, 0.22A, SOT-23 BSS138 Fairchild Semiconductor

Q7, Q8 2 50V MOSFET, N-CH, 50V, 0.22A, SOT-23 BSS138 Fairchild Semiconductor

R1, R2, R4, R22, R26, 
R29, R30, R33

8 10k RES, 10k, 5%, 0.063W, AEC-Q200 Grade 0, 0402 CRCW040210K0JNED Vishay-Dale
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Table 4-1. Bill of Materials (continued)
DESIGNATOR QUANTITY VALUE DESCRIPTION PART NUMBER MANUFACTURER

R3 1 100k RES, 100k, 5%, 0.1W, AEC-Q200 Grade 0, 0402 ERJ-2GEJ104X Panasonic

R5, R7, R9, R16, R41 5 1.0Meg RES, 1.0M, 5%, 0.1W, AEC-Q200 Grade 0, 0603 CRCW06031M00JNEA Vishay-Dale

R6, R8, R10, R15, R17 5 330 RES, 330, 5%, 0.063W, AEC-Q200 Grade 0, 0402 CRCW0402330RJNED Vishay-Dale

R11, R12, R13, R24 4 0 RES Thick Film, 0Ω, 0.2W, 0402 CRCW04020000Z0EDHP Vishay Dale

R18, R19, R35, R38 4 1.0k RES, 1.0k, 5%, 0.063W, AEC-Q200 Grade 0, 0402 CRCW04021K00JNED Vishay-Dale

R20 1 1.0Meg RES, 1.0M, 5%, 0.063W, AEC-Q200 Grade 0, 0402 CRCW04021M00JNED Vishay-Dale

R21 1 1.07Meg RES, 1.07M, 1%, 0.063W, AEC-Q200 Grade 0, 0402 CRCW04021M07FKED Vishay-Dale

R23 1 1.5k RES, 1.5k, 5%, 0.063W, AEC-Q200 Grade 0, 0402 CRCW04021K50JNED Vishay-Dale

R25, R27 2 33 RES, 33.0, 1%, 0.1W, AEC-Q200 Grade 0, 0603 CRCW060333R0FKEA Vishay-Dale

R28 1 120k RES, 120k, 5%, 0.063W, AEC-Q200 Grade 0, 0402 CRCW0402120KJNED Vishay-Dale

R31 1 1.50k RES, 1.50k, 1%, 0.1W, AEC-Q200 Grade 0, 0603 CRCW06031K50FKEA Vishay-Dale

SH-J1, SH-J3, SH-J4, 
SH-J6, SH-J7, SH-J8, 
SH-J9

7 1x2 Shunt, 100mil, Flash Gold, Black SPC02SYAN Sullins Connector Solutions

SW1 1 Switch Tactile N.O. SPST Round Button J-Bend 32VAC 
32VDC 1VA 100000Cycles 3N SMD Tube/T/R

KT11P3JM34LFS C&K Components

TP1, TP2, TP5, TP6, 
TP7, TP8, TP9, TP10, 
TP11, TP13, TP14, TP15, 
TP16, TP17, TP18, TP20, 
TP22, TP37, TP39, TP40, 
TP41, TP42, TP43, TP44, 
TP45

25 Test Point, Miniature, SMT 5015 Keystone Electronics

TP3, TP4, TP23, TP24, 
TP25, TP26, TP28, TP30, 
TP31, TP32, TP33, TP35

12 PCB Pin, Swage Mount, TH 2505-2-00-44-00-00-07-0 Mill-Max

TP46 1 Test Point, Compact, Yellow, TH 5009 Keystone Electronics

U1 1 TPS6521501WRHBRQ1 TPS6521501WRHBRQ1 Texas Instruments

U2 1 300mA, Ultra-Low-Noise, Low-IQ, High PSRR LDO TPS7A2033PDBVR Texas Instruments

U3 1 25MHz Mixed Signal Microcontroller with 128KB Flash, 
8192 B SRAM and 63 GPIOs, -40 to 85 degC, 80-pin 
QFP (PN), Green (RoHS & no Sb/Br)

MSP430F5529IPN Texas Instruments

U4 1 4-Channel USB ESD Solution with Power Clamp, 
DRY0006A (USON-6)

TPD4S012DRYR Texas Instruments

Y1 1 Crystal, 24.000MHz, 20pF, SMD ECS-240-20-5PX-TR ECS Inc.
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5 Additional Information

5.1 Trademarks
NexFET™ is a trademark of Texas Instruments.
Arm® and Cortex® are registered trademarks of Arm Limited.
Chrome® is a registered trademark of Google LLC.
Firefox® is a registered trademark of Mozilla Foundation.
Microsoft Edge® is a registered trademark of Microsoft Corporation.
All trademarks are the property of their respective owners.

6 Revision History
NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

Changes from Revision * (July 2025) to Revision A (September 2025) Page
• Added Setup section.......................................................................................................................................... 4
• Updated current capabilities............................................................................................................................... 4
• Updated default configuration of J3....................................................................................................................5
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING
Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers

and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI’s instructions for

electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

http://www.ti.com
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Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。 

https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-delivered-in-japan.html
3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified

by TI as conforming to Technical Regulations of Radio Law of Japan.
If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧くださ
い。https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-for-power-line-communication.html

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

http://www.ti.com
https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-delivered-in-japan.html
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https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-for-power-line-communication.html
https://www.ti.com/ja-jp/legal/notice-for-evaluation-kits-delivered-in-japan.html
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4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

http://www.ti.com
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8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265 
Copyright © 2023, Texas Instruments Incorporated
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IMPORTANT NOTICE AND DISCLAIMER
TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE 
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS” 
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD 
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate 
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable 
standards, and any other safety, security, regulatory or other requirements.
These resources are subject to change without notice. TI grants you permission to use these resources only for development of an 
application that uses the TI products described in the resource. Other reproduction and display of these resources is prohibited. No license 
is granted to any other TI intellectual property right or to any third party intellectual property right. TI disclaims responsibility for, and you fully 
indemnify TI and its representatives against any claims, damages, costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale, TI’s General Quality Guidelines, or other applicable terms available either on 
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable 
warranties or warranty disclaimers for TI products. Unless TI explicitly designates a product as custom or customer-specified, TI products 
are standard, catalog, general purpose devices.
TI objects to and rejects any additional or different terms you may propose.
IMPORTANT NOTICE

Copyright © 2025, Texas Instruments Incorporated

Last updated 10/2025

https://www.ti.com/legal/terms-conditions/terms-of-sale.html
https://www.ti.com/lit/pdf/SZZQ076
https://www.ti.com
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